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Chapter 1 ••••  

Real IP Apps Solutions Overview 

 Real IP Apps is a server-based application suite that functions as a proxy for client software 
applications to interface with the Real IP Apps Suite. Simply put: the Real IP Apps server provides 
the interface between the desktop applications and the voice communication system and supports 
applications such as QueVueTM, Call Director, Virtual DSS and AccuCall-Web reporting. 

 QueVueTM 

 QueVueTM is a software application that works in unison with the station and simplifies an ACD 
agent’s ability to login and out of multiple ACD groups while viewing up to eight ACD queues 
simultaneously.  QueVueTM consists of the QueVueTM Administrator and the QueVueTM Agent 
applications. 

Users must have both a PC and a key telephone on their desks.  

 

 
 

 QueVueTM 

The QueVueTM features include: 

 Login to multiple ACD Groups with one login. 
 View up to eight ACD Groups. 
 ACD Group details: Overflow indication, number of calls in queue, and number of agents 

logged in to each group. 
 Call Control for Answer, Hold, Record, and Disconnect. 
 ACD Control for Login / Logout, Wrap-up, and Not Available. Login also allows the user to 

select preferred ACD queues that are logged into most frequently. 
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 Virtual DSS 

The Virtual DSS is a highly customizable application that provides easy access to other telephones 
using the PC—eliminating bulky, hardware-based DSS units. It was designed to greatly reduce 
overall call handling time and provide visual indication of the current status of each telephone, all 
while maximizing the user’s desk space.  

Vitural DSS ConsoleVitural DSS ConsoleVitural DSS ConsoleVitural DSS Console

 
 VIRTUAL DSS 

The Virtual DSS is intended to improve the productivity of power users like receptionists, 
administrative assistants and other employees with heavy call volume. 
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Single click operation to: 
 Call another station 
 Retrieve an incoming call from a call covered station  
 Transfer a call to another station 
 Transfer a call to a voicemail box 
 Park a call at another station 
 Park a call on a group park orbit 

Status indication of: 
 Incoming calls to a station 
 Station on call 
 Stations in Do Not Disturb (DND)  
 Calls parked at a station 
 New voice message at a station 

Drag and Drop – The Virtual DSS Console is easily customized. Users can quickly change the 
layout by dragging the desired name or extension from the  Real IP Apps Company Phonebook, and 
dropping it onto the desired Virtual DSS key. Key changes are instant, with no separate databases to 
edit or upload. 

Integrated Tutorial Movie - The Virtual DSS Console includes an integrated tutorial movie that 
walks users through all the features and basic configuration options they are likely to use. 

Console Integration - The Virtual DSS Console integrates with all stations including the new Icon 
Series phones. 

Remote Users - Remote workers have full access to the Virtual DSS features. The only requirement 
is a VPN connection to access the Real IP Apps. 
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Call Director 

The Call Director is a desktop call control application for station users. The Call Director is a simple, 
intuitive application that installs on the user’s PC and provides visual indication of incoming and 
outgoing calls. 

ABC CompanyABC Company

 
CALL DIRECTOR 

Incoming Call Screen Pop -includes caller’s name and number. 

Call Control -The Director provides the following call control features:  

 Make a call 
 Place a call on hold 
 Disconnect a call 
 Directory dial 
 Answer a call 
 Record a call 
 Transfer a call 
 Transfer to Voicemail 

User Status - The Call Director includes a User Status feature that integrates with the company 
phonebook, allowing coworkers to view user status. Status settings include In Office, Away on 
Business, Extended Absence, At Lunch, Meeting, On Vacation and Temporary Location. 

Call Forwarding–Call Director may be used to forward all incoming calls to another extension or an 
external number such as a cell phone. This setting also integrates with the Soft (PC) Attendant 
Phonebook and allows others to view your forwarded status. 

Directory – The Call Director has a directory feature that provides two views, the Company 
Phonebook which lists all ECS extensions, and personal contacts imported directly from Microsoft 
Outlook. The Company Phonebook is a shared resource with other  Real IP Apps such as the Soft 
(PC) Attendant Console and Virtual DSS. The Company Phonebook is user-organized by extension 
number, first name, last name or department. More importantly, Call Director users simply select the 
person they wish to call and click the dial button. 

Call Log – The call log feature maintains a record of all incoming and outgoing calls for one month. 
It can be used to both quickly reference and dial past calls.
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Use the Call Director Remotely – Remote workers have full access to the Call Director features. 
The only requirement is a VPN connection to access the Real IP Apps. 

Soft (PC) Attendant Console 

Soft (PC) Attendant Console is a software application that works in unison with the station and 
facilitates users placing, transferring, and holding calls through the PC. While anyone can use the 
application, the Soft (PC) Attendant is primarily designed for power users such as the attendant 
position and department assistants. 

 
Soft (PC) Attendant Console 

The Soft (PC) Attendant Console is a modern alternative to bulky attendant consoles. Features 
include: 

 Call Transfer.  
 Blind Transfer.  
 Transfer to Voicemail.  
 Attendant Call Park Orbit and Page.  
 Direct Station Selection with Status Indication.  
 Company Phonebook with One-Touch Dialing and Status Indication.  
 Drag and Drop Call Transfer. 
 ‘Notes’ column in phonebook allows attendants to add notes about specific extensions such as 

“Out to lunch,” “In Meeting,” or “On Vacation.”  
 Color-coded departmental listings and sort by department feature.  
 Call Log provides information about all calls that ring the extension.  
 Four call coverage buttons, independent of the telephone.  
 Recall information includes caller ID name and number and recalling extension ID. 
 Status column in phonebook includes a ‘PARK’ indication when a call is parked at an extension. 
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AccuCall-Web 

AccuCall-Web, a call accounting application created specifically for the Enterprise-CS of ICON 
Series Phones, allows administrators to monitor and track day-to-day telephone system usage. The 
browser based AccuCall-Web Advanced allows users to log in remotely to view system information 
and/or generate historical reports. Administrators are no longer limited to accessing reports from PCs 
loaded with a software package. Detailed reports can be generated based on call flow by account 
code, department/group extensions and trunk/trunk groups. These categories are easily configured 
using system information provided directly from the ECS database. AccuCall-Web Advanced also 
features drill-down navigation that allows users to extract additional details from reports.  

There are two versions of AccuCall-Web, Advanced and Standard. Features of each version include: 

AccuCall Web Advanced 
Forced Account Code Reporting – The Forced Account Code CSTA enhancement enables the 
Iwatsu Enterprise Services AccuCall-Web Advance application to receive Forced Account Code 
information for Account Code reporting purposes. This feature requires ECS software version 5.2 
or higher and AccuCall-Web Advanced 2.3 or higher. 

Call Visualiser – Use hyperlinks to navigate through all the reported call data. Easily drill down 
beyond summary data to get more detail on caller ID, call progress, account code, time spent in 
process, etc. AccuCall-Web Advanced supports full cradle-to-grave reporting for each call. 
IP Campus – AccuCall-Web Advanced is supported in ECS IP Campus applications, and identifies 
IP Campus nodes in the reports. 
Costing – Generate costing reports with assigned cost-per-minute values. Costing rates can be 
assigned to area codes, trunks or trunk groups for incoming and outgoing calls (7 digit, 10 digit and 
international numbers are supported). 
ACD Reports – View reports generated by ACD Queue and ACD agent. 
Extension Reports – View reports generated by extension or station ID and assign phone charges 
based on cost. 
Review and Manage Data – Directly print from the browser or export reports to Adobe® 
Acrobat (PDF) and Microsoft® Excel, and other formats supported by Microsoft Reporting Services. 
Simultaneous Users – Up to ten simultaneous users may view the AccuCall-Web Advanced and 
data reports. 

AccuCall-Web Standard 
Call Visualiser – Use hyperlinks to navigate through all the reported call data. Easily drill down 
beyond summary data to get more detail on caller ID, call progress, account code, time spent in 
process, etc. 
IP Campus – AccuCall-Web is supported in ECS IP Campus applications, and identifies IP 
Campus nodes in the reports. 
Costing – Generate costing reports with assigned cost-per-minute values. Costing rates can be 
assigned to area codes, trunks or trunk groups for incoming and outgoing calls (7 digit, 10 digit and 
international numbers are supported). 
Extension Reports – View reports generated by extension or station ID and assign phone charges 
based on cost. 
Review and Manage Data – Directly print from the browser or export reports to Adobe® 
Acrobat (PDF) and Microsoft® Excel, and other formats supported by Microsoft Reporting Services. 
Simultaneous Users – Up to ten simultaneous users may view the AccuCall-Web and data 
reports.
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Text Web 

Ticker and Text Web are features of the ICON Series Telephones that support LCD display of 
information from the internet, internal databases, or other sources.  Ticker displays information as 
scrolling text on the first or second line of the display on an ICON Series telephone.  Text Web 
provides a menu-driven interface for information access from an ICON Series IP Telephone (IX-
5930/IX-5910 only). 

The Ticker and Text Web application software is a component of Iwatsu Enterprise Services 3.0 or 
later. The ECS is programmed with a URL from this application and makes requests to obtain 
specified information. The Ticker and Text Web application retrieves this information, re-formats it, 
and sends the information back to the ECS. 

Ticker Interaction 

 
For Ticker, the technician programs the ECS with the URL(s) of the Text Web application necessary 
to obtain the desired information. The ECS makes requests to the Ticker / Text Web application and 
periodically refreshes the Ticker Field Display on supported ICON Series Telephones. 

Text Web Interaction 

 
Within the ECS, Text Web is configured similarly to the Ticker. However, Text Web is only 
applicable on the Iwatsu ICON Series IP Telephones (IX-5930/IX-5910) and a Text Web key must 
be included in the key pattern on the telephone. Text Web data sent from the Iwatsu Ticker / Text 
Web application to the ECS describes the content displayed on the LCD and the actions taken when 
the Text Web key is pressed. This data is limited to 10,000 characters. 

Text Web allows you to program a formatted URL and have that information display on ICON 
Series IP Telephones. As an example Text Web can be programmed to display weather, news, 
famous quotes, or stock quotes on the display of the ICON Series IP Telephones (IX-5930/IX-5910 
only). 

Text Web Integrator 
The Text Web Integrator application installs on a user’s PC and enables Text Web to launch 
applications on the user’s PC when requested. When this application is installed, the user’s extension 
number must be entered for the application to function. 
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Enterprise Services Phone Book 

Enterprise Services includes tools to import or export a phone book, edit the phone book, 
synchronize the phone book, and edit ECS stations in the phone book. The phone book is used by the 
Iwatsu Soft (PC) Attendant, Virtual DSS, and the Call Director applications. The Soft (PC) 
Attendant application can also be used to create or edit phone book data. 

The phone book that is created in the Soft (PC) Attendant or via a comma-separated values (.csv) file 
imported into Enterprise Services is used to populate the Virtual DSS and Call Director applications. 

 
Enterprise Services 

The Soft (PC) Attendant is the only application that allows you to edit phone book information. If 
you do not have the Soft (PC) Attendant, the phone book .csv file must be edited and uploaded 
through Real IP Apps.  

 

 
Soft (PC) Attendant 
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Chapter 2 ••••  

AccuCall-Web Advanced 

Introduction 

AccuCall-Web Advanced is a call reporting application created specifically for the Iwatsu 
Enterprise-CS that monitors and tracks day-to-day telephone system usage. This application works in 
conjunction with Iwatsu Enterprise Services to access the CSTA data stream from the Iwatsu 
Enterprise-CS. The browser based AccuCall-Web Advanced allows users to log in remotely to view 
system information and/or generate historical reports. 

AccuCall-Web Advanced Advantages 

AccuCall-Web Advanced has several advantages over AccuCall-Web Standard which include: 

 Supports multiple call transfers. 

 Displays call flow information for the entire call. Not limited to two transfers. 

 Differentiates between transferred calls and call conference calls. 

 Displays ACD reports. 

 Displays DNIS reports. 

 Displays Trunk Busy Statistics. 

 Displays ICM calls. 
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Details 

A key improvement with AccuCall-Web Advanced is the browser based access, which 
eliminates extra software and improves access to reported data. Administrators are no 
longer limited to accessing reports from PCs loaded with a software package. Detailed 
reports can be generated based on call flow by account code, department/group extensions 
and trunk/trunk groups. These categories are easily configured using system information 
provided directly from the ECS database. AccuCall-Web Advanced also features drill-
down navigation that allows users to extract additional details from reports. Improvements 
to AccuCall-Web Advanced include: 

Account Code Reporting – Run reports based on the account code entered with the 
call. This feature requires ECS software version 5.2 or higher and AccuCall-Web 
Advanced 2.3 or higher. 

Call Visualizer – Use hyperlinks to navigate through all the reported call data. Easily drill 
down beyond summary data to get more detail on caller ID, call progress, account code, 
time spent in process, etc. 

IP Campus – AccuCall-Web Advanced is supported in ECS IP Campus applications, and 
identifies IP Campus nodes in the reports. 

Costing – Generate costing reports with assigned cost-per-minute values. Costing rates 
can be assigned to area codes, trunks or trunk groups for incoming and outgoing calls (7 
digit, 10 digit and international numbers are supported). 

ACD (Contact Center) Reports – View reports generated by ACD Queue and ACD 
agent. 

Extension Reports – View reports generated by extension or station ID and assign 
phone charges based on cost. 

Review and Manage Data – Directly print from the browser or export reports to 
Adobe® Acrobat (PDF) and Microsoft® Excel, and other formats supported by Microsoft 
Reporting Services. 

Simultaneous Users – Up to ten simultaneous users may view the AccuCall-Web 
Advanced and data reports. 
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AccuCall-Web Advanced Report Manager 
Navigation Overview 

The AccuCall-Web Advanced Report Manager is divided into nine report folders that 
contain the following detailed reports: Account Codes, ACD, Call Visualiser, Campus, 
Department, Extension, Extension Group, Trunk, and Trunk Group. 

Iwatsu AccuCall-Web Advanced
Reports Home

AccuCall-Web Advanced
AccuCall-Web Advanced Reports

ACD

Call Visualiser

Campus

Department

Extension

Extension Group

Trunk

Trunk Group

ACD Queue Detailed Hourly
ACD Queue Start Date

All Calls By Dept Start Date
All Calls By Start End Date
All Calls Detailed Hourly
All Calls Grouped By Ext and Start Date
Calls By Caller ID Number
Calls By Dialed Number
DNIS All Start Date

Campus Cost Report
Campus Detailed Hourly

Department Cost Report
Department Detailed Hourly
Department Report

Extension Comparison Detailed Hourly
Extension Detailed Hourly
Specific Extension Cost

Extension Group Cost Report
Extension Group Detailed Hourly

Trunk Cost
Trunk Hourly Report

Trunk Group Cost
Trunk Group Busy Hourly Chart
Trunk Group Detailed Hourly
Trunk Group Usage Chart

All Account Code Cost
Specific Account Code Cost

Account Codes

All Qualification Codes Report
Detailed Agent Activity
Specific Qualification Code Report
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AccuCall-Web Advanced Advantages 

The AccuCall-Web Advanced Programmer configuration determines the format of the 
reports in the Report Manager. The Report Manager is where the CSTA data that is sent 
from the ECS is viewed. This section will help you access, navigate, and use the Report 
Manager. For more information, refer to the AccuCall-Web Advanced User’s Manual by 
selecting Help in the Report Manager. 

 If SQL Server Express resides on another PC or server, open Internet Explorer and 
go to the URL below. The IP address in the example below will differ from the IP 
address of the PC or server where SQL Express resides. 
(Example: http://192.168.125.215/Reports$SQLEXPRESS) 
or 

 If you are using the PC or server where SQL Server Express resides, open Internet 
Explorer and go to URL: http://localhost/Reports$SQLEXPRESS 

Contents Tab 

 The Contents tab is where you find the Home > AccuCall-Web Advanced > 
AccuCall-Web Advanced Reports folder and sub-folders that contain CSTA 
data. 

 

 The nine report folders shown below are found under Home > AccuCall-Web 
Advanced > AccuCall-Web Advanced Reports. 

 
 

http://localhost/Reports$SQLEXPRESS
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AccuCall-Web Advanced Reports 
Account Codes 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Account 
Codes. The Account Codes folder contains two reports; All Account Code Cost and 
Specific Account Code Cost. Examples of each are shown below: 

 

 All Account Code Cost report example: Select the Start Date and End Date and 
then press View Report to generate the report. 
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 Specific Account Code Cost report example: Select the Start Date, End Date, and 
the Extension number and then press View Report to generate the report. 

 
 

ACD 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > ACD. The 
ACD folder contains five reports; ACD Queue Detailed Hourly, ACD Queue Start Date, 
All Qualification Codes Report, Detailed Agent Activity, and Specific Qualification 
Code Report. Examples of each are shown below: 
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 ACD Queue Detailed Hourly report example: Select the Start Date and End Date 
and the Que access number and then press View Report to generate the report. 

 

 ACD Queue Start Date report example: Select the Start Date and End Date and 
then press View Report to generate the report. 

 



Real IP Apps User Guide    

16 

  All Qualification Codes Report example: Select the Start Date and End 
Date and then press View Report to generate the report. 

 
 Detailed Agent Activity report example: Select the Start Date, End Date, and the 

Extension number and then press View Report to generate the report. 
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 Specific Qualification Code Report report example: Select the Start Date, End 
Date, and the Qualification Code and then press View Report to generate the 
report. 
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ACD Specific Call Master 
ACD is capable of displaying expanded call details for ACD calls through the Specific Call 
Master. Expanded call details are viewed by selecting the hyperlinked (underlined) view 
call details data fields contained in the reports. The number of calls in the ACD Queue at 
the time of the selected call can also be viewed. 

 In the ACD report, select view call details for a specific call. 
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The Specific Call Master displays Call Details, Call Flow, and Call Cradle to Grave 
information. 

 Call Details: Displays Call Type, Call Result, Call Date/Time Stamp, Duration, 
Trunk, Call, Ring Duration, and Duration to Answer by Person. 

 Call Flow: Displays the Extension, Name, Date/Time Stamp, Call Steps, Duration, 
Trunk, Called Number, Caller ID Name, Caller ID Number, DNIS number, 
Number of ACD Calls in Queue, and Number of Automated Attendant Call in 
Queue. 

 Call Cradle to Grave: Displays Call States for the entire duration of the call. 
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 To view the Call States in bar chart format, select Duration Chart at the bottom 

of the Call Cradle to Grave table. 
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 To view call details for the calls in queue for a specific call, select # of ACD 

Queue for the specified call. 

 
 ACD Call Queue details are displayed. 
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Call Visualiser 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Call 
Visualiser. The Account Visualiser folder contains four reports; All Calls by Dept Start 
Date, All Calls by Start End Date, All Calls Detailed Hourly, and All Calls Grouped by Ext 
and Start Date. 

 Call Visualiser reports. 

 

 Call Visualiser All Calls By Dept Start Date report example: Select the Start 
Date, End Date, and the Department and then press View Report to generate the 
report. 
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  Call Visualiser All Calls By Start End Date report example: Select the Start Date 
and End Date and then press View Report to generate the report. 

 

 Call Visualiser All Calls Detailed Hourly report example: Select the Start Date 
and End Date and then press View Report to generate the report. 
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 Call Visualiser All Calls Grouped By Ext and Start Date report example: Select 
the Start Date and End Date and then press View Report to generate the report. 

 

 Call Visualiser Calls By CallerID Number report example: Select the Start Date, 
End Date, and enter the CallerID Number you want to view and then press View 
Report to generate the report. (The Caller ID Number entered must be an exact 
match to the number you want to run the report for.) 
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 Call Visualiser Calls By Dialed Number report example: Select the Start Date, 
End Date, and enter the Dialed Number you want to view and then press View 
Report to generate the report. (The Dialed Number entered must be an exact match 
to the number you want to run the report for.) 

 

 Call Visualiser DNIS All Start Date report example: Select the Start Date and End 
Date and then press View Report to generate the report. 
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Call Visualiser Specific Call Master 
The Call Visualiser is capable of displaying expanded call details for calls, trunks, and 
ACD calls through the Specific Call Master. Expanded call details are viewed by selecting 
hyperlinked (underlined) data fields contained in the reports. Calls by Extension, Date and 
Time Stamp, and Trunks can be expanded. 

 
The Specific Call Master displays Call Details, Call Flow, and Call Cradle to Grave 
information. 

 Call Details: Displays Call Type, Call Result, Call Date/Time Stamp, Duration, 
Call, Ring Duration, and Duration to Answer by Person. 

 Call Flow: Displays the Extension, Name, Date/Time Stamp, Call Steps, Duration, 
Trunk, Called Number, Caller ID Name, Caller ID Number, and DNIS number. 

 Call Cradle to Grave: Displays Call States for the entire duration of the call. 
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Call State Duration Chart 

The Duration Chart at the bottom of the Call Cradle to Grave information 
allows you to view the call states in bar chart format. 
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Campus 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Campus is 
used to generate reports specific to Iwatsu  IPCampus networks. The Campus folder 
contains two reports; Campus Cost Report and Campus Detailed Hourly report. 

 Campus reports. 

 

 Campus Cost Report example: Select the Start Date, End Date, IP Campus 
Node, and the Call Type and then press View Report to generate the report. 
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 Campus Detailed Hourly Report example: Select the Start Date, End Date, and 
the IP Campus Node and then press View Report to generate the report. 
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Department 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Department. 
The Department folder contains three reports: Department Cost Report, Department 
Detailed Hourly, and Department Report. 

 Department Reports:  

 

 Department Cost Report example: Select the Start Date, End Date, Call Type, and 
Department and then press View Report to generate the report. 
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 Department Detailed Hourly Report example: Select the Start Date, End Date, and 
Department and then press View Report to generate the report. 

 

 Department Report example: Select the Start Date, End Date, and Department and 
then press View Report to generate the report. 
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Extension 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Extension. 
The Extension folder contains three reports, Extension Comparison Detailed Hourly, 
Extension Detailed Hourly report, and Specific Extension Cost. 

 Extension Report. 

 

 Extension Comparison Detailed Hourly Report example: Select the Start Date, 
End Date, and the 1st, 2nd, and 3rd Extensions to compare and then press View 
Report to generate the report. A report will not appear for an extension when no 
activity exists for the range selected. 
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 Extension Detailed Hourly Report example: Select the Start Date, End Date, and 
the Extension and then press View Report to generate the report. 

 

 Extension Specific Extension Cost Report example: Select the Start Date, End 
Date, Call Type, and Extension and then press View Report to generate the report. 
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Extension Groups 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Extension 
Groups. The Extension Groups folder contains two reports: Extension Group Cost 
Report and Extension Group Detailed Hourly. 

 Extension Group Reports. 

 

 Extension Group Cost Report example: Select the Start Date, End Date, Station 
Group, and Call Type and then press View Report to generate the report. 
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 Extension Group Detailed Hourly report: Select the Start Date, End Date, and 
Station Group and then press View Report to generate the report. 

 



Chapter 2                                                              AccuCall-Web Advanced 

37 

Trunk Reports 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Trunks. The 
Trunk folder contains two reports; Trunk Cost and Trunk Hourly Report. 

 Trunk Reports. 

 

 Trunk Cost Report example: Select the Start Date, End Date, and Trunk number 
and then press View Report to generate the report. 

 
 



Real IP Apps User Guide    

38 

 

 Trunk Hourly Report example: Select the Start Date, End Date, and Trunk 
number and then press View Report to generate the report. 
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Trunk Groups 
Home > AccuCall-Web Advanced > AccuCall-Web Advanced Reports > Trunk 
Group. The Trunk Group folder contains four reports; Trunk Group Cost, Trunk Group 
Busy Hourly Chart, Trunk Group Detailed Hourly, and the Trunk Groups Usage 
Chart. 

 Trunk Group reports. 

 

 Trunk Group Cost Report example: Select the Start Date, End Date, and Trunk 
Group number and then press View Report to generate the report. 

 



Real IP Apps User Guide    

40 

 

 Trunk Group Cost Chart example: Select view chart to view the report chart. 

 

 Trunk Group Busy Hourly Chart Report example: Select the Start Date, End 
Date, and the Trunk Group number and then press View Report to generate the 
report. 
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 Trunk Group Detailed Hourly Report example: Select the Start Date, End Date, 
and Trunk Group number and then press View Report to generate the report. 

 

 Trunk Group Usage Chart Report example: Select the Start Date, End Date, and 
Trunk Group number and then press View Report to generate the report. 
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Properties tab: 

General 
Under the Properties > General tab you will find general information about the folder as 
shown below:  

 Edit Site Name: Select Site Settings (upper right corner of the Reports window) to 
edit the Site Name. 

 
 Enter the new Site Name and select Apply to save the save your changes. 
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Security 
Under the Security tab, you can: 

 Create a New Role Assignment: Create a new user. 

 Revert to Parent Security: Reverts the security settings for a sub-folder to that of 
the parent folder. 

 Delete a user: Delete a user account. 

New Role Assignment  
 Select New Role Assignment to create a new user. 
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 Enter the Group or user name: for example: iai\shibiv. 

 Select the Role you want the new user to have. Each Role assignment has a 
detailed description next to the specific role. Selecting the Browser Role is typical. 

 Once the Role is selected, press OK to add the new user. 

 

 The new user and their role will appear under the Security tab. 

Edit a Role Assignment 
 To Edit a Role Assignment: 

 Select Edit next to the Group or User you want to edit. 
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 Select the new role assignment for the selected user. 

 Select OK to make the change. 

 
Delete a Role Assignment 

 To Delete a Role Assignment: 

 Select the box next to the Group or User you want to delete to activate the Delete 
tab. 

 

 Select Delete and then select OK when the Are you sure you want to delete this 
item? window appears. 
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Troubleshooting 

This trouble-shooting guide contains the following trouble-shooting tips: 
 Uninstall SQL Server 2005. 
 Configure IIS Settings for a Workgroup. 
 Encryption Key error when running reports. 
 Report Server receives an error when connecting to the database. 
 Login screen pop when running the reports and the login screen does not take my user 

name and password. 
 Running reports from a remote computer. 
 Cannot run reports after a computer name change. 

Note: 
If your Iwatsu Enterprise-CS system has been re-started, verify that the ACWeb-CSTA Service 
is running and collecting data. 

Uninstall SQL Server 2005 

To uninstall SQL Server 2005: 

1. Go to Start > Settings > Control Panel > Add or Remove Programs. 

 Select (highlight) Microsoft SQL Server 2005 and press Remove. 
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2. Select the SQLEXPRESS Database Engine, Reporting Services radio button and the 
Workstation Components checkbox. 

 Select Next > to continue 

 
 Press Finish to begin the uninstall process. This process will take a few minutes to 

remove all the components. 
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 The uninstall process begins. 

 
 Close the Add or Remove Programs window after uninstall is complete. 

3. Go to Start > Settings > Control Panel > Add or Remove Programs and find and 
select Microsoft SQL Server Native Client. 

 Select Remove to uninstall the Native Client and select Yes to confirm the 
removal. 

 
 Remove any other Microsoft SQL Server programs in the Add or Remove 

Programs list. 
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4. Right-click on Start and select Explore to open the File Explorer and go to C: 

Program Files and delete the Microsoft SQL Server folder and all its contents.  

 Select Yes when the Confirm Folder Delete message box appears. 

 
 Now you are ready to install SQL Server again. 

Configuring IIS Settings for Workgroup 

To configure IIS for Workgroups: 

1. Go to Start > Settings > Control Panel > Administrative Tools. 

 Double-click on Internet Information Services and expand local computer > 
Web Sites > Default Web Site. 

 Right-click on Reports$SQLEXPRESS and select Properties. 
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2. Select the Directory Security tab and select Edit in the Anonymous access and 
authentication control area. 

 
 Uncheck the Integrated Window authentication box (for the domain) and check 

the Basic authentication (password is sent in clear text) box. 
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 When you check the Basic authentication box select Yes to continue when the 
Internet Service Manager screen appears. 

 
 The Authentication Methods screen should now appear as shown below: 

 

3. Select OK to close the Authentication Methods window and then select OK to exit the 
IIS Properties window. 
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Encryption Key Error 

Encryption key errors can be caused by: 

1. Changing the computer from a Workgroup to a domain or vice-versa. 

2. Losing power. 

3. Cannot connect to a domain server when the computer is set as part of a domain. 

4. Windows Auto-update is set for automatic and the computer reboots. 

Solutions: 
1. Restore Encryption key backup. If an Encryption key backup exists: 

 Go to: Start > All Programs > Microsoft SQLServer 2005 > Configuration Tools > 
Reporting Services Configuration 

 Select Connect button. 
 Select Encryption Keys and Select Restore. 

2. If no Encryption key backup exists, perform the following procedure: 
 Delete Encryption key  
 Go to: START > PROGRAMS > MICROSOFT SQL SERVER 2005 > 

CONFIGURATION TOOLS > REPORTING SERVICES CONFIGURATION >  
 Click on CONNECT 
 Click on ENCRYPTION KEYS 
 Click on DELETE button 
 Add encryption key, username and password  
 Launch Internet Explorer URL:  

http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx 
 Click on SHOW DETAILS  
 Click on DATA SOURCES folder 
 Click on CSTADATASOURCE folder 
 Make sure check on ENABLE THIS DATA SOURCE 
 Type CONNECTION STRING as follows: 

 Advanced:   Data Source=localhost\SQLExpress;Initial 
Catalog=AccuCallWebCSTA 

 Standard:  Data Source=localhost\SQLExpress;Initial Catalog=SMDR 

Note that there is a space between Data and Source. Also between Initial and 
Catalog 

 Check : Credentials stored securely in the report server 
 Username:   sa 
 Password:     iwatsu10 

http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx
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 Click on APPLY 
3. Adding the Encryption key back in MS SQL 2005 

 Go to: START > PROGRAMS > MICROSOFT SQL SERVER 2005 > 
CONFIGURATION TOOLS > REPORTING SERVICES CONFIGURATION > 

 Click on CONNECT 
 Click on ENCRYPTION KEYS 
 Click on BACKUP button 
 Password: iwatsu 
 Click on Key File 
 Type on File Name and SAVE 

4. If the Restore and Delete Encryption keys are disabled 

This is because SQL Server did not start up properly on boot up. Also, this can be 
caused when the SQL Server cannot talk to the Domain Controller if it is set up for 
Domain. If this is a Domain Controller issue, the user should seriously consider setting 
up the computer as a WORKGROUP. 
 Stop and start Services 
 START > PROGRAMS > CONTROL PANEL >  
 ADMINISTRATIVE SERVICES 
 Click on SERVICES  
 STOP [In this order] 

 SQL Reporting Service 
 SQL Server (SQL Express) 

 START [In this order]  
 SQL Server (SQL Express) 
 SQL Reporting Service 

 Go back to the previous step to restore or delete encryption keys. 
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Report Server Receives an Error when Connecting to the 
Database 

If you receive this error message:  

 
This is due to the fact that the SQL Server did not start up properly on boot up. Also, this 
can be caused when the SQL Server cannot talk to the Domain Controller if it is set up for 
Domain. If this is a Domain Controller issue, the user should seriously consider setting up 
the computer as a WORKGROUP. 

Stop and Start Services 
 START > PROGRAMS > CONTROL PANEL >  
 ADMINISTRATIVE SERVICES 
 Click on SERVICES  
 STOP [In this order] 

 SQL Reporting Service 
 SQL Server (SQL Express) 

 START [In this order]  
 SQL Server (SQL Express) 
 SQL Reporting Service 

 Go back to the previous step to restore or delete encryption keys. 

Login Screen Pops when Running the Reports and the Login 
Screen will not take my Username and Password 

Cause 

IIS is setup for domain and your computer is set up as a WORKGROUP or vice-versa. 

Solutions: 
1. Check your computer settings. 

 Control Panel->System -> Computer name. 
 This will show if it set up for domain or work group. 

2. Check your IIS settings. 
 Control Panel > Administrative Tools > Internet Information Services. 
 Expand Web Sites. Expand Default Web Site. 
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 Select Reports$SQLExpress and right click to select Properties. 

 Select Edit to go to Authentication and Access Control. 

 
 For Domain, the screen below is correct. Integrated Windows authentication is 

checked. 
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 For WORKGROUP, change the settings to the match the below screen, where 
Basic authentication is selected. 

 

Running Reports from a Remote Computer 

Assign the user in the AccuCall-Web for permissions: 
 Pull up Internet Explorer URL:  

http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx 
 Select Properties->Security. 
 Select New Role Assignment. 

 
 If it is in a domain called cti, set the user name as cti\gregh 
 If it is a workgroup called workgroup, set the user name as workgroup\gregh. 
 Check Browser for viewing and running reports. 

 Make sure firewall is turned OFF. 

http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx
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 From the client machine, Pull up Internet Explorer URL:   

 http://l0.129.0.20/reports$SQLEXPRESS/Pages/Folder.aspx 
 If the IP address of the AccuCall-Web machine is 10.129.0.20 
 You should be asked for the username and password. 

Cannot Run Reports after a Computer Name Change 

1. Change Database Setup to (LOCAL)\SQLEXPRESS 
 START > PROGRAMS > MICROSOFT SQL SERVER 2005 > 

CONFIGURATION TOOLS > REPORTING SERVICES CONFIGURATION > 
 Click on CONNECT 
 Click on DATABASE SETUP 
 Go to Server name: hit drop down find (LOCAL)\SQLEXPRESS  
 Click on CONNECT  May error still  

2. Stop and Start Services 
 START > PROGRAMS > CONTROL PANEL > ADMINISTRATIVE 

SERVICES 
 Click on SERVICES  
 STOP [In this order] 

 SQL Reporting Service 
 SQL Server (SQL Express) 

 START [In this order]  
 SQL Server (SQL Express) 
 SQL Reporting Service 

3. Delete encryption key  
 START > PROGRAMS > MICROSOFT SQL SERVER 2005 > 

CONFIGURATION TOOLS > REPORTING SERVICES CONFIGURATION  
 Click on CONNECT 
 Click on ENCRYPTION KEYS 
 Click on DELETE button 

4. Add encryption key, username and password back 
 Pull up Internet ExplorerURL:  

http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx 
 Click on SHOW DETAILS  
 Click on DATA SOURCES folder 
 Click on CSTADATASOURCE folder 

http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx
http://localhost/reports$SQLEXPRESS/Pages/Folder.aspx
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 Make sure check on ENABLE THIS DATA SOURCE 
 Type CONNECTION STRING as follows: 

 Advanced: Data Source=localhost\SQLExpress;Initial 
Catalog=AccuCallWebCSTA 

 Standard: Data Source=localhost\SQLExpress;Initial Catalog=SMDR 
 Check: Credentials stored securely in the report server 
 User name: sa 
 Password: iwatsu 

 Click on APPLY 
5. Adding the encryption key back in MS SQL 2005 

 START > PROGRAMS > MICROSOFT SQL SERVER 2005 > 
CONFIGURATION TOOLS > REPORTING SERVICES CONFIGURATION  

 Click on CONNECT 
 Click on ENCRYPTION KEYS 
 Click the BACKUP button 

 Password: iwatsu 
 Click on Key File 
 Type on File Name and SAVE 
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Chapter 3 ••••  
QueVueTM 

Overview 

QueVueTM is a software application that works in unison with the station and simplifies an ACD 
agent’s ability to login and out of multiple ACD groups while viewing up to eight ACD queues 
simultaneously. QueVueTM consists of the QueVueTM Administrator and the QueVueTM Agent 
applications. 

Users must have both a PC and a key telephone on their desks.  

 
QueVueTM 

QueVueTM Agent Features 

The QueVueTM features include: 

 Login to multiple ACD Groups with one login. 
 View up to eight ACD Groups. 
 ACD Group details: Overflow indication, number of calls in queue, and number of agents 

logged in to each group. 
 Call Control for Answer, Hold, Record, and Disconnect. 
 ACD Control for Login / Logout, Wrap-up, and Not Available. Login also allows the user to 

select preferred ACD queues that are logged into most frequently. 
 

Important! 
The QueVueTM requires Iwatsu Enterprise-CS (ECS) software version 5.2 or 
higher and Iwatsu Enterprise Services software version 3.x or higher. 
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 QueVueTM Administrator Configuration and User Guide 

The QueVueTM Administrator application is used to assign ACD Groups to ACD Agents, ACD 
Agent Login Priority for ACD Groups, set queue threshold levels and expansion timers, and 
download ECS ACD database information. 

 If you installed the QueVueTM Administrator application on a standalone PC, double-click the 
shortcut icon to launch the administrator application.  

 
 If you are accessing the QueVueTM Administrator through Iwatsu Enterprise Services 3.0, go 

to the App Data tab and then select ACD QueVue Administrator to launch the 
administrator. 

 
 

Main Screen Overview 
This portion of the help system contains information to help you get familiarized with the QueVueTM 
Administrator. 

When the QueVueTM Administrator application is launched from a standalone PC, you will only see 
a File drop-down menu and the Server menu. Once you have connected to the Enterprise Services 
Server you will have access to the following menus: 

 Server – The Server menu is used to connect to the Enterprise Services Server and displays the 
Administrator connection status. 

 If you are accessing the QueVueTM Administrator through Iwatsu Enterprise Services you 
will not see the Server menu. 

 Agent ID – The Agent ID menu displays the ACD Agent IDs and Name (if assigned). 

 Agent Logins – The ACD Agent Logins menu displays all assigned agent names and ACD 
Groups. 

 ACD Groups – The ACD Groups menu displays the ACD Group ID, Access Number, Name, 
the call threshold level (low, medium, and high),and the Expansion Timer. 
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 Supervisors – The Supervisors menu allows you to view the supervisor names and IDs. 

 Q Threshold – The Q Threshold determines the color for the ACD Group queue when the Low, 
Medium, and High call thresholds are exceeded. 

QueVue AdministratorQueVue Administrator

 
File Menu 

Use the File drop-down menu to Import an ECS Database or Exit the application. 

 
 Import ECS Database – Import ACD database information from the ECS. 

 You must import the ECS database information before you can begin configuring the 
Iwatsu QueVueTM Administrator. This is required to import the ACD Agents, ACD Groups, 
and Supervisor database information from the ECS. 

 Exit – Exit the application. 
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Import ECS Database 
You must import the ECS database information before you can begin configuring the QueVueTM 
Administrator. This is required to import the ACD Agents, ACD Groups, and Supervisor database 
information from the ECS.  

Note: 
It is highly recommended that you import the ECS database when ACD programming 
changes are made to the ECS database.   

 From the File drop-down menu, select Import ECS Database. 

 
 Locate and select the ECS database file that you need to import. Press Open to import the 

database to QueVueTM. 

 

Help Menu 
Use the Help drop-down menu to open the Programming Guide or view information About this 
application. 
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Server 
The Server menu is used to connect to the Iwatsu Enterprise Services Server and displays the 
Administrator connection status. If you are accessing the QueVueTM Administrator through Iwatsu 
Enterprise Services you will not see the Server menu. 

 Select the Server menu and enter the Iwatsu Enterprise Services Server IP Address and then 
select Connect. 

 The connection status will display below the server IP address. 
QueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministratorQueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministrator

 

Agent ID 
The Agent ID menu displays the ACD Agent IDs and Name (if assigned):  

 If a Name is not assigned to the Agent ID, then the Agent ID is not displayed. 

 You can assign or change an Agent Name by double-clicking the Name text box associated 
with an Agent ID number and type the Agent Name (eight characters max). This does not 
change the ECS database only the way the ACD Agent ID appears in QueVueTM. 

 Agent Names are programmed in the ECS database under Incoming Calls > ACD > 
Agents > Agent Features > Name (Class 20.01). 

 Select Display All Agents to show all 1,024 programmable ACD Agents. 

 When you have completed making your changes, select Update to save your changes to Iwatsu 
Enterprise Services. 

QueVue AdministratorQueVue Administrator
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Agent Logins 
The ACD Agent Logins menu displays ACD agents (with names assigned) and ACD Groups (with 
assigned names and access numbers). From this menu, you can also set the ACD Agent Login 
Priority for each ACD Group. 

ACD Groups Tab 

From the ACD Groups tab: 

 Select (highlight) the ACD Agent ID Name and then select the ACD Groups the agent can 
login to and/or view. 

 If an ACD Agent Name or ACD Group does not appear in this list, there is no Agent Name 
or ACD Group Name/Access Number assigned. 

 Make sure that you select Update to save your changes. 
QueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministratorQueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministrator
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Priority Tab 
 ACD Group Agent Login Priority – Select the agent’s login Priority level for each ACD 

Group and select which of those selected ACD Groups the Agent can login to and/or view. 

 Priority – Set the login Priority for each group. Use the drop-down menu to change the priority 
level from Priority_1 (default) to Priority_2, Priority_3, or VIEW_QUEUE (if you only want 
the agent to view and not login to that group). 

 View – If you want the agent to view an ACD Group in QueVueTM, you must select the check 
box for each ACD Group you want displayed in the QueVueTM agent console. 

 The ACD Agent can view up to eight ACD Groups. If more than eight groups are selected, 
only the first eight are displayed in Iwatsu QueVueTM. 

 Allow Agent to override Administrator Priority – Check this box if you want to the agent to 
be able to change his/her priority level in Iwatsu QueVueTM. When this box is not selected 
(checked) the agent cannot change his/her ACD Group Priority. 

 Disallow Agent Log-in/out Control – Check this box if you do not want the agent to select 
which ACD Groups he/she can log-in to. When this box is selected (checked), the agent can 
only log-in or out of all assigned ACD Groups. 

QueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministratorQueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministrator
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ACD Groups 
The ACD Groups menu displays the ACD Group ID, Access Number, Name, the call threshold level 
(low, medium, and high),and the Expansion Timer: 

 If an Access Number and Name are not assigned to the ACD Group, the ACD Group is not 
displayed. 

 You can assign or change a Name by double-clicking the Name text box associated with an 
ACD Group ID number and type the Name (eight digits max). This does not change the ECS 
database. 

 Select Display All ACD Groups to show all 250 programmable ACD Groups. 

ACD Group Parameters: 

 Programmed in the ECS database under Incoming Calls > ACD > Group Data. 

 ID – ACD Group ID number.  

 Access No – ACD Group Access number.  

 Name – ACD Group Name (eight digit max).  

 Threshold Level: - Used to define three levels to indicate the number of call waiting in 
queue.) 

 Low = 1 call (default) 

 Medium = 2 calls (default) 

 High = 3 calls (default) 

 Expansion Timer (in seconds) – Used to program a duration after which expansion from 
one ACD to another ACD Group occurs.  

 Range = 0 – 999 seconds. 

 Default = 0.  
QueVue AdministratorQueVue Administrator

 
 When you have completed making your changes, select Update to save your changes to Iwatsu 

Enterprise Services. 
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Supervisors 
The Supervisors menu allows you to view the supervisor names and IDs that are programmed in the 
ECS database under Incoming Calls > ACD > Supervisor. Supervisors must login through the 
telephone. 

 Id: Supervisor ID number 1-30. 

 Name: Displays the supervisor names. You can add or change a supervisor name by double-
clicking on the Name field and typing a new supervisor name (1-8 characters). 

 Display All Supervisors: Check the Display All Supervisors box if you want to display all 
supervisor positions with and without a Name assigned. 

QueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministratorQueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministrator

 
 Remember to select Update to save your changes. 

Q Threshold 
The Q Threshold determines the color for the ACD Group queue when the Low, Medium, and High 
call threshold levels are met. 

QueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministratorQueVueQueVueQueVueQueVue AdministratorAdministratorAdministratorAdministrator
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 To change a threshold color: Click on a threshold color to open the Color palette and select a 
new color for the specific threshold level.  

 Changing the threshold color changes the color for all QueVueTM ACD agent users (this is a 
global change). 

 
 Press OK to save your changes. 

 Remember to select Update to save your changes. 
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 QueVueTM Agent User Guide 

The QueVueTM user guide will help you get familiarized with the features and functionality of this 
application.  

To launch QueVueTM, select the icon in the PC system tray and then select QueVue from the pop-up 
menu. 

 If the QueVueTM icon does not appear in the PC system tray, double-click the shortcut icon on 
the PC desktop to start the application. 

 

Pop-Up Menu 
To launch the Pop-Up menu, simply click on the QueVue icon in the PC system tray. From the Pop-
Up menu, you can select: 

 Configure – Launches the QueVueTM Configurator. 

 QueVue – Launches the QueVueTM Agent window. 

 Help – Launches the QueVueTM User Guide. 

 About – Displays the QueVueTM version number. 

 Exit - Closes the QueVueTM application. 

 

Call Queue Indication 
When QueVueTM is running in the PC system tray and the QueVue agent window is closed, the 
QueVue icon will turn red to indicate that there is a call in queue. 

 The icon will remain red until you open the QueVue agent window regardless of whether or not 
the call that triggered the indication is still in the queue of one of the ACD Groups that you are 
viewing. 

 You will not receive this indication if the QueVue agent window is open. 
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Main Screen Overview 
The QueVueTM main screen is divided into four sections:  

 Call Control – The Call Control section allows you to Answer a call, place a call on Hold, 
Record a call, and Disconnect a call. 

 ACD – The ACD section allows you to Log-in/out of ACD groups, set your availability and 
Wrap Up. The Log-in feature also allows you to select preferred ACD groups for quick 
login/logout. 

 ACD Group Call Queue – This section displays up to eight ACD Groups and displays the 
ACD group name, number of calls in queue, the longest waiting call (LWC) in the queue, and an 
indication if the overflow timer has been exceeded. 

 Incoming Call Information– Caller ID name (if available) and number and the ACD Group 
where the incoming call was in queue. 

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue

9729290242972929024297292902429729290242

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue

9729290242972929024297292902429729290242

 
 You can expand and collapse the Call Control / ACD section by selecting arrow at the bottom of 

the screen. 
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Call Control 
From the Call Control panel, you can: 

 Answer an ACD call that is ringing your station. 

Note: 
When a call is answered using the Answer button, the receive audio is sent to the 
speaker on the agent’s telephone. 
Only the Headset key (key # 105) is supported for QueVueTM. The Headset Control 
key (key # 198) is not supported. 

 Place an ACD call on Hold. 

 Record an ACD call. The recorded conversation is sent to your station’s voice mailbox when 
recording is complete. You must have a Record key in the key pattern of your telephone to 
support the Call Record feature. 

Important! 

IMPORTANT NOTICE REGARDING THE CALL RECORDING FEATURE 
In certain states it is illegal to intercept and/or record telephone calls. 
In certain states and under certain circumstances it is illegal to intercept for the 
purposes of listening in and/or recording telephone calls. Because such activity 
is not illegal in all jurisdictions and may be permitted in training and/or 
monitoring of personnel, this telephone system can be programmed to permit 
interception and/or recording with or without warning to those on the line. Before 
utilizing the system for such purposes, you are advised to consult with an 
attorney familiar with laws of the jurisdiction in which you utilize such feature. 
IWATSU VOICE NETWORKS, its distributors, and the manufacturers 
responsible for this feature make no representations with respect to the legality 
of its use and disclaim any liability for claims and/or damages arising from the 
use or misuse of this feature. 

 

 Disconnect (hang-up) an ACD call. 

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue
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ACD 
From the ACD panel, you can: 

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue

 
 Log-in / out of an ACD group or groups. Selecting the Log-in / out button will launch the Agent 

Login/Logout window. 

From the Agent Login/Logout window you can: 

 Login or Logout of individual ACD groups 

 Login or Logout of all ACD groups 

 Login or out of a preferred ACD group or groups. Selecting the Preferred check box for an 
ACD group or groups allows you to quickly login to that group or groups by selecting the 
Login Preferred button. 
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 If you do not see the Login Preferred button or the Action or Preferred columns in the 
Agent Login/Logout screen, you do not have permission to access these items. 

 
 Wrap Up is the amount of wrap-up time allotted to an agent upon entering the wrap-up mode. 

This item is only used if the agent is programmed for automatic wrap-up. Pressing the Wrap Up 
button, during wrap up, will end the wrap time. 

 The agent can extend wrap-up time equal to the value programmed in this item by pressing 
the Wrap Up key on the telephone while the warning tone is audible. This item is 
programmed in the ECS database under Incoming Calls > ACD > Agents > Agent 
Features > Wrap-up Time (Class 20.12). 

 Unavailable - Change your availability status Available / Unavailable. Calls will not ring at 
your station while you are unavailable. 

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue
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ACD Group Call Queue 
The ACD Group Call Queue section displays up to eight ACD groups, the group name, number of 
calls in the queue, the longest waiting call (LWC) time, and an indication if the overflow timer has 
been exceeded. The ACD group color will change based on the threshold level programmed in the 
QueVueTM Administrator for low, medium, and high call thresholds. 

 ACD Group Name – Hovering the cursor over the ACD group name displays the queue 
number, group access number, group name, the number of agents logged in, the agent’s ID 
number, extension, name, and date and time the agent logged in. Supervisors logged in to the 
group are displayed at the bottom of the pop-up. 

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue

 
 Calls – Calls displays the number of calls in the queue for a specific ACD group. By hovering 

the cursor over Calls displays the name (if available), number, type of call, and the date and time 
the call entered the queue. 

QueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVueQueVue

 
 LWC – Longest Waiting Call displays the length of time that the longest waiting caller has 

been in the queue. 

 Overflow Indication – If a call in the queue exceeds the expansion timer setting, the overflow 
indication is a green dot that will appear to the right of the ACD call queue.  

 Threshold Indication – When an ACD call queue meets the low, medium, or high call 
threshold level, the queue will change color to indicate the threshold level. The threshold level 
and colors are programmed using the QueVue Administrator.
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Chapter 4 ••••  
Soft (PC) Attendant Console 

Overview 

Soft (PC) Attendant Console is a software application that works in unison with the station, and 
facilitates placing, transferring, and holding calls through the PC. While anyone can use the 
application, Soft (PC) Attendant is primarily designed for users with heavy call volumes such as the 
attendant position and department assistants. 

Users must have both a PC and a key telephone on their desks. A hands-free headset is 
recommended.  

 

 
Soft (PC) Attendant Console 
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Features 

The Soft (PC) Attendant Console is a modern alternative to bulky attendant consoles. Features 
include: 

 Call Transfer.  
 Blind Transfer.  
 Transfer to Voicemail.  
 Attendant Call Park Orbit and Page.  
 Direct Station Selection with Status Indication.  
 Company Phonebook with One-Touch Dialing and Status Indication.  
 Drag and Drop Call Transfer. 
 ‘Notes’ column in phonebook allows attendants to add notes about specific extensions such as 

“Out to lunch,” “In Meeting,” or “On Vacation.”  
 Color-coded departmental listings and sort by department feature.  
 Call Log provides information about all calls that ring the extension.  
 Four call coverage buttons, independent of the telephone.  
 Recall information includes caller ID name and number and recalling extension ID. 
 Status column in phonebook includes a ‘PARK’ indication when a call is parked at an extension. 

Important! 
The Soft (PC) Attendant Console requires Iwatsu Enterprise-CS (ECS) 
software version 4.02 or higher. 

 

Network Phonebook 
The Soft (PC) Attendant Console allows multiple Soft Attendant clients to share the same 
company-wide network phonebook. Edits made from one client are viewable by all users. 
Soft (PC) Attendant Console users can also hide seldom used extensions from the network 
phonebook by using an “Ignore Extensions” list.  
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Configuration 

Iwatsu Soft (PC) Attendant Application Topology

Soft (PC) Attendant Client

Iwatsu Enterprise Application 
Gateway
Dell GX755 Server Includes:
-Iwatsu Enterprise Services 2.3
-(2) Soft (PC) Attendant Client Licenses

Enterprise Services 2.3 may be
downloaded from Iwatsu.com for 
no charge and installed on a 
dealer approved PC

Soft (PC) Attendant
Client

ECS CSTA Output
License Required
(PN: 000322)

Soft (PC) Attendant Application TopologyIwatsu Soft (PC) Attendant Application Topology

Soft (PC) Attendant Client

Iwatsu Enterprise Application 
Gateway
Dell GX755 Server Includes:
-Iwatsu Enterprise Services 2.3
-(2) Soft (PC) Attendant Client Licenses

Enterprise Services 2.3 may be
downloaded from Iwatsu.com for 
no charge and installed on a 
dealer approved PC

Soft (PC) Attendant
Client

ECS CSTA Output
License Required
(PN: 000322)

Soft (PC) Attendant Application Topology

 

Enable Single Step Transfer 
The CSTA Single Step Transfer enhancement greatly increases the speed in which the Call Director 
and Soft (PC) Attendant transfers a caller to an individual voice mailbox. This feature eliminates the 
voice mailbox greeting audio burst heard in previous versions when using the Call Director and Soft 
(PC) Attendant to transfer calls to voicemail. 

If you have ECS version 4.0 or higher, enable Single Step Transfer. 

If your ECS is running a software version below 4.0 proceed to the Voice Mail Configuration 
on the following page. 

1. Select Misc tab on the Configuration screen. 

 Check (to enable) the Enable Single Step Transfer (ECS 4.0 + Only) box. 
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2. Select the OK button. 

Voicemail Configuration 

If your ECS system software version is below version 4.0, follow the voice mail configuration 
procedures in this section. If your ECS system software version is 4.0 or higher, enable Single Step 
Transfer as shown on the previous page. 

The IX-4VML, IX-4SEVMC, IX-4EVMC and the VS-VML card on an IX-VMAC are compatible 
with Iwatsu Enterprise Services and Soft (PC) Attendant Console. Because the configuration of all 
four products is the same, they will hereafter be referred to as ‘Omega-Voice.’ 

Additionally, Soft (PC) Attendant Console and Iwatsu Enterprise Services are compatible with the 
Enterprise TOL voicemail server. This section of the document explains the procedure used to 
configure the Omega-Voice or the Enterprise TOL for use with Iwatsu Soft (PC) Attendant Console 
and Iwatsu Enterprise Services. 

Omega-Voice Configuration 
The Omega-Voice product line must be properly configured before it is compatible with the Iwatsu 
Enterprise Services. Because the Omega-Voice is highly configurable, this section explains one 
solution. Customer voicemail systems differ in their configuration, though the principles described 
here still apply. 

Configuring Menus 
1. Launch the Omega-Voice VMI Editor 3.00 or higher. 
2. Select the Edit a Menu icon. 
3. Enter 900 in the Menu Number text box. 
4. Select the Receive button. 

 
5. Under the 8 digit, select Transfer from the Action drop down menu. This is the digit used 

in default by the Iwatsu Enterprise Attendant Console. If a digit other than 8 will be used, 
the Menu Option Digit in Iwatsu Enterprise Attendant Console configuration must reflect 
the new digit. 
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It is good practice to program the steering digit 8 
outside the mailbox range. In this example, 8 is 
numerically higher than 4 (400-499).  
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6. Select Menu option from the Sub Action drop down menu. 

7. Enter 901 in the parameter field. 

 
8. Select the Send Button. 

9. Select the Create New Menus button. 

 
10. Select the Create a standard automated attendant menu radio button. 

11. Enter 901 in both the Starting number and the Ending number textbox. 

12. Select the OK button. 

 
13. Enter 900 in the Menu Number text box. 
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14. Select the Receive button. 

 
15. Make sure all options in the Action menu are None. 

16. Make sure all options in the Sub Action menu are None. 

17. In the Default field, set the Action dropdown menu to Transfer. 

18. In the Default field, set the Sub Action dropdown menu to Mailbox. 

 
19. Select the Send/Close button. 



Real IP Apps User Guide    

82 

 

User Guide 

Main Screen Overview 
This portion of the help system contains information to help you get familiarized with the PC 
Attendant. 

The PC Attendant has four drop-down menus, three Action Buttons, a Department drop-down menu, 
and a Data Search text box. Extensions that are assigned to the same Department are color coded for 
ease of use and an extension Status Indicator appears next to each extension. When an extension is 
selected, it will appear just below the Data Search text box. 

Use the graphics below to become familiar with the layout of the Soft (PC) Attendant. 

Idle Call Screen 
Call control operations for the PC Attendant are accessed from the PhoneBook context menu or from 
the action buttons to the right of the search textbox (Refer to the graphic below). 

If there is not an active call, the PC Attendant can perform the following call control operations: 

 Make a Call 

 Pickup a Call (Pick up a ringing extension) 

 Call Voicemail (Directly call a voice mailbox) 

Idle main screen with Call, Pickup, and Call VM Action buttons 

Search TextboxSearch TextboxSearch TextboxSearch TextboxSearch TextboxSearch TextboxSearch TextboxSearch Textbox
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Active Call Screen 
If a call is currently active for the extension, the Action Buttons change (see screen shot below). 
Active call control operations are:  

 Transfer Call (Tran) 

 Announced Transfer (A-Tr) 

 Transfer to Voicemail (VM) 

 Group Park (G-Pk) 

 Transfer to Park (T-Pk) {also known as Individual Transfer } 

Active call display screen with available Action Buttons: Transfer, Announced Transfer, Transfer 
to Voicemail, Group Park, and Transfer to Park. 

Search TextboxSearch TextboxSearch TextboxSearch TextboxSearch TextboxSearch TextboxSearch TextboxSearch Textbox

 

File Menu 
From the File drop-down menu, you can select: 

 View Call Log - Displays Name, Phone Number, and Date/Time of received calls. 

 Exit - Closes the PC Attendant application 
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To view the Call Log: 

 Select File > View Call Log 

 

Options Menu 
From the Options drop-down menu, you can access the following: 

 Find 

 Basic Configuration 

 Ignored Extensions 

 Call Coverage 

 Attendant Extension 

 Advanced Configuration 

 

Find 
 Select Options > Find or Ctrl+F to place the cursor in the search text box. 
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Basic Configuration: 
 Search by: Search for an entry by First Name, Last Name (Default), or Department. 

 Select the incoming call Screen Pop Action: Ring Pop (Default), Answer Pop, or No Pop. 

 Clear Headset Calls: Select the Clear Headset Calls checkbox if you are having trouble 
disconnecting calls. 

 Auto Minimize: Select the Auto Minimize check box if you want the PC Attendant to 
automatically minimize when idle 

 
 Press Accept to save your configuration changes. 

Ignored Extensions: 
Select extensions that you do not want to appear in the PhoneBook. Ignored extensions appear with a 
red minus next to the extension number in the Ignored Extension screen. 

 Double-click on the PhoneBook entry to change the status to / from ignored. 

 You can also choose to Show All or Hide All PhoneBook entries. 

 
 Press Accept to save your changes. 
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Call Coverage: 
Create Call Coverage keys for extensions: 

 To Add an extension: Enter the extension number in the text box next to the Add button. Press 
Add this number to the Extensions to Cover list. 

 To Remove an extension: Select the extension from the Extensions to Cover list and select 
Remove. 

 To change the order in which the Call Coverage keys appear: Select the extension from the 
Extensions to Cover list and press Up or Down to rearrange the order of the extensions. 

 
 Press Accept to save your changes. 

Attendant Extension: 
The Attendant Extension option displays your current extension number. 
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To change your extension number: 

 Enter your new extension and press OK. 

 To verify the extension you will be asked to pick-up and then hang-up the handset. 

 

Advanced Configuration: 
The Advanced Configuration menu allows you to enter/change your ECS system information and 
extension location information.  

 To access the Advanced Configuration menu: Enter the Password (default = dist) and press 
Connect. 

 

Main Tab 
The Main configuration tab allows you to change the Administrator Password. To the change the 
Admin password: 

 Enter the new password in the Admin Password and Password Confirm text boxes. 

 Press OK to save. 
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Voicemail Tab 
From the Voicemail tab, enter the ECS voice mail Hunt Group Access Number (voice mail 
extension), Menu Option Digit (voice mail dialing digit), and the Post Menu Output Delay (timing 
delay). 

 

ParkOrbits Tab 
From the ParkOrbits tab, enter the ECS Park Orbit extensions: 

 To Add a Park Orbit extension: Enter the extension in the text box next to the Add button and 
press Add. 

 To Remove a Park Orbit extension: Select the Park Orbit extension from the extension list and 
press Remove. 

 To Change the Park Orbit extension order: Select a Park Orbit extension from the extension 
list and press the Up or Down arrows to rearrange the Park Orbit extension order. 
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DNIS Tab 
From the DNIS tab, enter your DNIS Number and Label information. 

 

Locations Tab 
Location tab entries can be used for two different functions: 

 IPNET Networking - When used for IPNET Networking, enter the location Name and 
Number. 

 Sortable PhoneBook field - Enter a location Name to be associated with a PhoneBook entry. 
The Number field is used only when used with IPNET Networking. 
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Miscellaneous Tab 
The Misc (Miscellaneous) tab is used to enable Single Step Transfer for ECS systems with ECS 
software 4.0 or higher.  

 Enable Single Step Transfer (ECS 4.0+ Only) - The CSTA Single Step Transfer enhancement 
greatly increases the speed in which the Call Director and Iwatsu Soft (PC) Attendant transfers a 
caller to an individual voice mailbox. This feature eliminates the voice mailbox greeting audio 
burst heard in previous versions when using the Call Director and Soft (PC) Attendant to 
transfer calls to voicemail. 

 

Call Menu 
From the Call drop-down menu, you can access the following features when your station is idle: 

 Make Call 

 Pickup Call 

 Call Voicemail 

 Retrieve Parked Call 

 
You can access the following features when you are on a call: 

 Transfer - Transfer a call to another extension. 

 Announce Transfer - Supervised transfer. 

 Voicemail - Transfer a call to a voice mailbox. 

 Park and Page - Place a call in Park Orbit and enter the Page Group Number. 

 Hold - Place a call on hold. 
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 Hang Up (X) 

 

Help Menu 
From the Help menu, you can access the following Help options: 

 Attendant Overview 

 CSTA Trouble-Shooting 

 About Enterprise PC Attendant 

 Help 

 

Department Menu 
Select a Department: 

To filter and view a specific Department: 

 Select a Department from the drop-down menu on the right. 
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Double-Click or Right-Click Menu 

If you double-click or right-click on a highlighted entry (or in the directory area) the Context Menu 
will appear. 

The following menu choices are available when your station is idle: 

 Make Call - Call the extension that is highlighted. 

 Pickup Call - Pickup a call for the extension that is highlighted. 

 Call Voicemail - Call your voice mailbox. 

 Edit PhoneBook - Make changes to the PhoneBook. 

 Show Current Dept Only - Only available when a specific Department is being viewed. 

 Show Active Call Entries - Displays only active extensions. 

 Configure PhoneBook - Allows you to make changes to the PhoneBook configuration. 

The following menu choices are available when your station is active: 

 Transfer - Transfer a call. 

 Announce Transfer - Announce a call transfer. 

 Transfer to Voicemail - Transfer a caller to voice mail. 

 Group Park - Place the call in Group Park. 

 Individual Park - Place the call on Individual Call Park. 

 Edit PhoneBook - Make changes to the PhoneBook. 

 Show Current Dept Only - Only available when a specific Department is being viewed. 

 Show Active Call Entries - Displays only active extensions. 

 Configure PhoneBook - Allows you to make changes to the PhoneBook configuration. 
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Edit the PhoneBook 
To make a change to the PhoneBook, right-click and select Edit PhoneBook to make a change to a 
directory listing.  

 Double-click on the Ext, First Name, Last Name, or Note field to edit the entry. 

 Use the drop-down menu to select a new Dept associated with the directory listing. 

 
To Save Changes or Cancel Changes and return to the main directory: 

 Right-click and select Save Changes or Cancel Changes and you will return to the main 
directory view. 

 

Show Current Dept Only 
When All Depts are being viewed in the main directory, the Show Current Dept Only cannot be 
selected. You must select a Department from the top right drop-down menu to view only one 
Department for this option to become active. 
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To return to the main directory: 

 Right-click and select Show All Departments to return to the main directory view. 

 

Show Active Call Entries 
When you select Show Active Call Entries only extensions that are busy or in Do Not Disturb 
(DND) will appear in the directory. 

 
To return to the main directory: 

 Right-click and select Show All Entries to return to the main directory view. 
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Configure the PhoneBook 
The PhoneBook configuration menu allows you to change the attributes of the PhoneBook as well as 
password protects the PhoneBook from unauthorized editing. The PhoneBook attributes that you can 
change/set are listed below: 

 Select Display Columns - Select the columns to display in the PhoneBook. 

 Department List - Edit, add, and delete Departments. 

 Hilight Colors - Select the hilight colors for each Department. 

 Refresh Interval - Select the refresh rate in seconds (10 - 600 seconds). 

 Locking and Passwords - Edit administrative and user passwords 

 

Select Display Columns... 
Select Display Columns allows you to add or remove columns from the PhoneBook view. 

 
From the Column Selector you can choose which of the following columns are visible when 
viewing the PhoneBook:  

 First Name 

 Last Name 

 Dept (Department) 

 Status 

 Note 

 Loc (Location) 
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By default, First Name, Last Name, Dept, Status, and Note columns appear in the PhoneBook view. 

 Select OK when you have made your selection changes. 

 

Department List... 
The Department List allows you to add, modify, delete, or change the color of a Department. 
Departments in the Department List appear in the Department drop-down menu. 

 
 Double-click on a Dept entry to add, modify, or delete the Department. 

 Double-click on a Department Color to launch the Color palette which allows you to change 
the color associated with that Department. 

 Select OK to save your changes. 
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Hilight Colors... 
Hilight Colors allows you to change the text and background colors for a selected PhoneBook entry. 

 
 Double-click on the Background Color or Foreground Color to launch the Color palette. 

 Select the new color and press OK to change the Background or Foreground Color. 

 

Refresh Interval... 
Select the Refresh Interval to change the PC Attendant status refresh rate. 

 
 Enter a refresh interval of 10 - 600 seconds (Default refresh rate = 10 seconds) and press OK. 
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Locking and Passwords... 
PC Attendant supports password-controlled access to the shared PhoneBook as well as a locking 
mechanism to prevent conflicts which could occur if multiple users are simultaneously editing the 
PhoneBook. You can choose to use Locking and Passwords if you have more than one PC Attendant 
and/or you are concerned about multiple users editing the phonebook at the same time. 

 
 If a password is set, the user is prompted to enter that password the first time they attempt to edit 

the PhoneBook or Department List after starting the PC Attendant. 

 
 The locking feature comes into effect when you try to edit the PhoneBook while another user 

has it opened for editing. 

 
 You will be able to edit the phonebook if you select Unlock. However, the other person will see 

the following dialog when they attempt to save their changes. 

 
The same mechanism also controls access to the Department List. Unlocking should only be used as 
a last resort – for example when another user starts editing the phonebook and then goes out to lunch. 

Some sites choose to set a PhoneBook password as well as an Admin password. The Admin 
password controls access to the change password dialog and optionally can be required in order to 
unlock the PhoneBook.  

If your site is supporting two or more PC Attendants, Icon suggests that you install PC Attendant on 
two computers close to each other and experiment with the locking and password settings to decide 
what works best for the organization. 
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Chapter 5••••  
Virtual DSS 

Overview 

The Virtual DSS is a highly customizable application that provides easy access to other Iwatsu 
telephones using the PC - eliminating bulky, hardware-based DSS units. It was designed to greatly 
reduce overall call handling time and provide visual indication of the current status of each 
telephone, all while maximizing the user’s desk space.  

 

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

 
VIRTUAL DSS 

The Virtual DSS was intended to improve the productivity of power users like receptionists, 
administrative assistants and other employees with heavy call volume. Users must have both a PC 
and a key telephone on their desks. 
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Features 

Single click operation to: 
 Call another station 
 Retrieve an incoming call from a call covered station  
 Transfer a call to another station 
 Transfer a call to a voicemail box 
 Park a call at another station 
 Park a call on a group park orbit 

Status indication of: 
 Incoming calls to a station 
 Station on call 
 Stations in Do Not Disturb (DND)  
 Calls parked at a station 
 New voice message at a station 

Drag and Drop – The Virtual DSS Console is easily customized. Users can quickly change the 
layout by dragging the desired name or extension from the Iwatsu Real IP Apps Company 
Phonebook, and dropping it onto the desired Virtual DSS key. Key changes are instant, with no 
separate databases to edit or upload. 

Integrated Tutorial Movie - The Virtual DSS Console includes an integrated tutorial movie 
that walks users through all the features and basic configuration options they are likely to use. 

Console Integration - The Virtual DSS Console integrates with all stations including the new 
Icon Series phones. 

Remote Users - Remote workers have full access to the Virtual DSS features. The only 
requirement is a VPN connection to access the Iwatsu Enterprise Gateway. 

Call Forward a station to another extension or Personal Speed Dial Bin. 

Direct Station Selection / Call Coverage with Status Indication. 

Import a Company Phonebook via PC Attendant or a .csv file with One-Touch Dialing 
and Status Indication. 

Port Requirements - Does not require a port or port license on the ECS system. 
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 Virtual DSS Console Operation 

Double-click the Virtual DSS Console icon on your desktop to launch the console. 

 

Virtual DSS Console Setup 

Initially, there are no Attendant extensions configured in the Virtual DSS Console. A phone book 
imported from the Soft (PC) Attendant or a comma-separated values (.csv) file imported into 
Enterprise Services is used to populate the Virtual DSS Console. 

Import a Phone Book Using Iwatsu Enterprise Services 
Perform this procedure if you do not have Soft (PC) Attendant installed, If you have the Soft 
(PC) Attendant installed, you can skip to the next page – Add Extensions to the Virtual DSS 
Console. 

Import a phone book using Iwatsu Enterprise Services. The phone book data that is imported must be 
a comma-separated-values (.csv) file that must be in the format specified during the Import Phone 
Book procedure.  

 Launch Iwatsu Enterprise Services 

 Select the Miscellaneous tab. 

 Select Import Phone Book. 
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 From the Import PhoneBook screen: 

 Filename: Enter or browse to find your phone book .csv file. 

 Format: Use the drop-down menu to select your .csv file format for your phone book. 
Your phone book must be in a format that is supported in this drop-down menu. 

 Select Import to import your phone book into Iwatsu Enterprise Services.  

 Select Close. 

 
 You must Stop and then Start the CSTA and Monitor Services after you import a phone 

book. 

If you need to make changes to the phone book, edit the .csv file and repeat this procedure or you can 
edit the phone book using the PC Attendant. 

Add Extensions to the Virtual DSS Console 
Adding extensions to the console requires phone book data. Phone book data can come from the PC 
Attendant or the data can be imported from a .csv file that is imported into Iwatsu Enterprise 
Services. 

 Selecting the left-facing arrow on the bottom left of the screen will expand the console screen to 
enable you to add extensions and set your preferences. 

Virtual DSS ConsoleVirtual DSS Console
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 If you have the Iwatsu PC Attendant installed, the PC Attendant Phone Book is imported into 
the Virtual DSS Console. If you do not have PC Attendant installed, you will need to create a 
.csv file and import that data into Iwatsu Enterprise Services. 

 You cannot edit the phone book using this application. 

 Importing a phone book is detailed on page Error! Bookmark not defined.. 

 The phonebook data can be viewed by extension number or name by selecting the Ext or Name 
in the left-hand side of the screen. 

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

 
 To populate the Virtual DSS Console, select an Ext or Name from the left-hand side of the 

screen and drag and drop that Name or Ext on to one of the keys in the Virtual DSS. You 
can change or move an extension by dragging and dropping that extension onto another key. 

 It is highly recommended that you do not place duplicate extensions in the Virtual DSS 
Console. 

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console
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Virtual DSS Options 
From the Virtual DSS Options drop-down menu, you can: 

 View your DSS / Call Coverage keys by extension number or name. 

 Choose three themes (skins). 

 Change your Virtual DSS layout to one of eight choices. 

 Make changes to the basic configuration. 

 Change your associated attendant extension. 

 Choose whether or not the Virtual DSS window is always on top or not. 

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

 

Basic Configuration 
You can set your Virtual DSS Console to pop open when ringing, pop open when answering, or you 
can choose for the console not to automatically pop open when minimized. You can also set the 
console to Auto-Minimize when the associated station is on-hook. 

 Select Options > Basic Configuration. 

 Select the Ring Pop, Answer Pop, or No Pop radio button. If you want the console to auto-
minimize, check the Auto-Minimize box. 

 Select Accept to save your changes. 
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Change the Associated Attendant Extension 
You can change the associated Attendant Extension at any time by selecting Options > Attendant 
Extension… and entering a different extension number. 

 Select OK to save you change. 

 

Exit the Virtual DSS Console 
 Select File > Exit to close the application. 

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console
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Virtual DSS Console Help 
From the Help drop-down menu, you can view the Call State Color List, User Manual, or select 
About to view Virtual DSS Console version number. 

 The Call State Color List identifies the colors displayed for each DSS / CCV key state. 

 
 About Virtual DSS Console displays the console software version number. 

About Virtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

About Virtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

.NET Framework Version 2.0.50727.NET Framework Version 2.0.50727.NET Framework Version 2.0.50727.NET Framework Version 2.0.50727

About Virtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console
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About Virtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

.NET Framework Version 2.0.50727.NET Framework Version 2.0.50727.NET Framework Version 2.0.50727.NET Framework Version 2.0.50727
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Virtual DSS Console Operation 

From the Virtual DSS Console you can: 

 Park a call at a station. 

 Group Park a call. 

 Transfer a call to another station or to a voice mailbox. 

 Announce Transfer a call to another station. 

 Call a station. 

 Call Forward a station to another extension or an extension’s Personal Speed Dial Bin. 

DND (Do Not Disturb) 
The DND indicator will light when a station is placed in DND. 

Virtual DSS ConsoleVirtual DSS Console

 

Park 
To Park a call on a station’s Individual Park: 

 While on a call, select the Park key for the station where you want to park the call. The Park 
key will light blue when a station has a call parked at their station. 

 Stations must have a Park key to have a call parked at their station. 

Virtual DSS ConsoleVirtual DSS Console
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Transfer to Voice Mail 
To Transfer a call to a station’s voice mailbox: 

 While on a call, select the Vm key for the station where you want to transfer the call. The Vm 
key will light green when there is a voice mail message in the voice mailbox. 

Virtual DSS ConsoleVirtual DSS Console

 

Transfer a Call 
To Transfer a call to another station: 

 While on a call, select the station (station name or extension number) key of the station where 
you want to transfer the call. 

 For Announce Transfer, right-click on the desired DSS / CCV key where you want to 
transfer the call and select Announce Xfer (See Right-Click Menu). 

Virtual DSS ConsoleVirtual DSS Console

 

Group Park 
To place a call in Group Park: 

 While on a call, simply select on of your Group Park keys. The Group Park key will light red 
when there is a call parked on that key. Selecting the Group Park key will retrieve the call. 

Virtual DSS ConsoleVirtual DSS Console
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Dialing 
To call an extension, simply press the extension name or number. 

Virtual DSS ConsoleVirtual DSS Console

 

Right-Click Menu 

From the Right-click Menu, you can select Announce Transfer a call, Forward a station, and 
enable an Audible Call Coverage tone. 

Announce Transfer 
To Announce Transfer a call to another station: 

 While on a call, Right-click on the desired DSS / CCV key where you want to transfer the call. 

 Select Announce Xfer. 

 
 Make your announcement to the transferred station. 

 When you are ready to complete the transfer, select OK and the call is transferred. 
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Forward 
To Forward a DSS / Call Coverage key: (You must have a Forward key in the key pattern of the 
extension being forwarded) 

 Right-click on the desired DSS / CCV key and select Forward. 

Virtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

Virtual DSS ConsoleVirtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

Virtual DSS Console

 
 Enter the Forwarding Number (Where you want to forward calls for this extension). 

or 

 Enter 1-10 for the Forwarding Number to forward the station to a Personal Speed Dial Bin. 
(Personal speed dial numbers must be programmed using the Iwatsu Programmer or 
MyECPhone.) 

 Select OK. 

 
To Cancel Forwarding for an extension: 

 Right-click on the forwarded station and select Cancel Forward (You do not have to enter an 
extension number). 

 Select OK. 
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CCV Audible 
You can enable an audible tone on a DSS / Call Coverage key when that station receives a call. You 
must have a sound card and speakers on the PC where the Virtual DSS Console is installed for this 
feature.  

 Right-click on the Call Coverage key you want to enable the audible CCV key tone and select 
CCV Audible. 

Virtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

Virtual DSS ConsoleVirtual DSS Console

Virtual DSS ConsoleVirtual DSS ConsoleVirtual DSS ConsoleVirtual DSS Console

CopyrightCopyrightCopyrightCopyright©©©© 2008200820082008----2010201020102010

Virtual DSS Console

 

Display DSS / CCV Key Information 
To display information about a DSS / CCV key in the console: 

 Hover your cursor over a specific DSS / CCV key to display key information: 

 Extension, Name, Department, CCV Audible On/Off, and Forwarding status (if the station 
is forwarded). 

Virtual DSS ConsoleVirtual DSS Console
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Chapter 6 ••••  
Call Director 

Overview 

The Call Director is a desktop call control application for Iwatsu station users. The Call Director is a simple, 
intuitive application that installs on the user’s PC and provides visual indication of incoming and outgoing 
calls.  

Call DirectorCall DirectorCall DirectorCall Director

ABC Company

Call DirectorCall DirectorCall DirectorCall Director

ABC Company

 

       CALL DIRECTOR 

 

Call Director Topography 
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Features 

Incoming Call Screen Pop -includes caller’s name and number. 

Call Control -The Iwatsu Call Director provides the following call control features:  

 Make a call 
 Place a call on hold 
 Disconnect a call 
 Directory dial 
 Answer a call 
 Record a call 
 Transfer a call 
 Transfer to Voicemail 

User Status - The Iwatsu Call Director includes a User Status feature that integrates with the company 
phonebook, allowing coworkers to view user status. Status settings include In Office, Away on Business, 
Extended Absence, At Lunch, Meeting, On Vacation and Temporary Location. 

Call Forwarding– The Iwatsu Call Director may be used to forward all incoming calls to another extension 
or an external number such as a cell phone. This setting also integrates with the PC Attendant Phonebook and 
allows others to view your forwarded status. 

Directory – The Call Director has a directory feature that provides two views, the Company Phonebook 
which lists all ECS extensions, and personal contacts imported directly from Microsoft Outlook. The 
Company Phonebook is a shared resource with other Iwatsu Real IP Apps such as the PC Attendant Console 
and Virtual DSS. The Company Phonebook is user-organized by extension number, first name, last name or 
department. More importantly, Call Director users simply select the person the wish to call and click the dial 
button. 

Call Log – The call log feature maintains a record of all incoming and outgoing calls for one month. It can be 
used to both quickly reference and dial past calls. 

Use the Call Director Remotely – Remote workers have full access to the Iwatsu Call Director features. The 
only requirement is a VPN connection to access the Iwatsu Enterprise Gateway. 
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Call Director User Guide 

Welcome to the Call Director User Guide. This will guide you through the features and use of the Call 
Director application. The Iwatsu Call Director has the following features: 

Make a call Answer a call 

Call voice mail Record a call 

Place a call on hold Transfer a call 

Disconnect a call Office status 

Call forwarding Directory 

Call Log  

Overview 
The Call Director short-cut icon was placed on your desktop during the installation process. You will also see 
this icon in your system tray when the Call Director application is running. If you selected Auto-Start during 
the configuration process, the application will start automatically when the PC is rebooted. 

To start the Call Director: 

 Double-click the desktop icon or select Start > Programs > Iwatsu > Iwatsu Call Director > 
Iwatsu Call Director. 

 

 The Iwatsu Call Director icon will appear in your PC system tray when the application is running. 

 
To open the Call Director: 

 Right-click on the icon in the system tray to access the menu and then select Call Director. 
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 When idle, the Call Director will appear as shown below. 

Virtual DSS ConsoleVirtual DSS Console

 

 When the Call Director is active (i.e., you have an incoming call or you are on a call) feature buttons 
will appear with an action icon to indicate the features that are active based on the state of the station. 

Call Director
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Dial – Make a Call 
To make a call: 

 Press Dial to open the Dial window and then enter the number you want to call and press Dial. This 
number can also be copied and pasted into the Dial Number window. 

 You can also select and dial a number from the Call Log or the Directory (Phone Book). 

 

 For Outside line dial access: Go to your computer Control Panel > Phone and Modem Options 
and Edit your Location under the Dialing Rules tab and enter your outside line access number. This 
is typically set to 9. Refer to the Configuration section for instructions. 
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Answer – Receive a Call 
When you have an incoming call: 

 Press Answer to answer the call on speakerphone, or lift the telephone handset. 

 For voice announce calls: You need to press Answer to activate the feature buttons for the call. If the 
Answer button is not pressed when a voice announce call comes in, the call will continue to display 
Ringing for the duration of the call. 

Call DirectorCall Director

 

Hold – Place a Call On Hold 
While on a call: 

 Press Hold to place the call on hold.  

 To retrieve the call, press the Retrieve button. (The Answer button changes to Retrieve when a call 
is on hold) 

Call DirectorCall Director
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Transfer - Transfer a Call 
While on a call and you want to transfer the caller to another extension: 

 Select Transfer and the call is placed on Hold. 

 Enter the extension number where you want to transfer the call and press the Transfer button. You 
can also select the number from the Call Log or Directory. 

Call DirectorCall DirectorCall DirectorCall DirectorCall DirectorCall DirectorCall DirectorCall Director

 

VM Transfer- Transfer to Voice Mail 
While on a call: 

 Press the VM Transfer button and enter a voice mailbox number to direct the caller to a voice 
mailbox. 
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Record – Call Record 

Note: 
You must have a Call Record key in your station key pattern to support this 
feature. 

While on a call: 

 Press the Record button to begin recording. 

 To stop recording, press Stop Rec. 

 The recorded call is sent to your voice mail inbox.  

Call Director Call DirectorCall Director Call Director

 

Note: 

In certain states it is illegal to intercept, listen to, and/or record telephone calls. 
In certain states and under certain circumstances it is illegal to intercept for the 
purposes of listening in and/or recording telephone calls. Because such activity 
is not illegal in all jurisdictions and may be permitted in training and/or 
monitoring of personnel, this telephone system can be programmed to permit 
interception, listening to, and/or recording with or without warning to those on 
the line. Before utilizing the system for such purposes, you are advised to 
confirm the laws of the jurisdiction in which you utilize such features(s). Iwatsu 
Voice Networks and/or its Third Party manufacturers/suppliers disclaim any 
responsibility for improper or illegal use of the Call Record Feature and disclaim 
any obligations to render legal advice concerning this feature 

 

Disconnect – End a Call 
To end a call: 

 Press Disconnect button. 
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Forward – Forward Your Station 

Note: 
You must have a Forward key in your station key pattern to support this feature. 
Your station must be in the idle state set / cancel forwarding. 

To forward your telephone: 

 When your station is in an idle state, select the Forward button to open the Forward Your Phone 
window. 

 Forwarding Type: Select FORWARD. 

 Forwarding Number: Enter the extension where you want to forward your extension. 

 Select OK to forward. 

 Check Show when Status is Changed if you want the Forward Your Phone window to appear 
anytime you change your Status setting. 

 
To cancel forwarding: 

 Select the Forward button to open the Forward Your Phone window. 

 Forwarding Type: Select Cancel FORWARD. 

 Select OK to cancel forward. 
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Status – Set Your Status 
Presence management works in conjunction with the Soft (PC) Attendant application Phone Book. When you 
set your presence status, that information appears in the Soft Attendant Phone Book in the Note column next 
to your name and extension. 

To set or change your Status: 

 Select one of the Status choices (shown in the screen shot below) from the drop-down menu: 

 The selection that appears in the Status box also appears in the Note column of the Soft (PC) 
Attendant Phone Book next to your name and extension. 

Call DirectorCall Director
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 The Soft (PC) Attendant Phone Book reflects the Status setting in the Call Director. 

 

Call Log 
The Call Log maintains a record of all incoming and outgoing calls for one month. You can use the Call Log 
to reference past calls and to dial and transfer calls. 

To make a call using the Call Log: 

 Press Dial and then press Call Log. (If you do not press Dial, you can only view the Call Log) 

 Select the entry from the Incoming or Outgoing log and press OK. 

 The selected number will appear in the Dial dialog window. Then press Dial to make the call. 

Call DirectorCall Director

 



Chapter 6 Call Director 

123 

Directory 
The Directory contains two separate databases: The Phone Book and Outlook Contacts. You can use these 
two databases to lookup a number or to dial and transfer calls. 

Phone Book 
The Phone Book database is imported from the Soft Attendant application. If there is not a Soft (PC) 
Attendant on your system, the Phone Book tab will be empty. 

The Phone Book will display the extension state (DND, on a call, etc.), the extension number, First and Last 
Name, Department, Status, Note (the Presence status set using the Call Director), and Location. 

To make a call using the Phone Book: 

 Select Directory. 

Call DirectorCall Director

 

 From the Call Directory screen, select the Phone Book tab. 

 Select the entry you wish to call and then press Dial to make the call. 
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Microsoft Outlook Contacts 
Microsoft Outlook Contacts are imported from the user’s Microsoft Outlook Contacts (refer to page Error! 
Bookmark not defined.).  If you are not using Microsoft Outlook, the Outlook Contacts tab will be empty. 

Outlook Contacts will display the contact’s First and Last Name, Business Phone, Home Phone, and Mobile 
Phone numbers, if programmed in Microsoft Outlook. 

To make a call using Microsoft Outlook Contacts: 

 Select Directory. 

Call DirectorCall Director

 

 From the Call Directory screen, select the Outlook Contacts tab. 

 Select the entry you wish to call and then press Dial to make the call. 

 

Close – Close the Application Window 
To close the Call Director application window: 

Select Close to close the Iwatsu Call Director window. Selecting Close does not exit the application, but 
closes the application window. The application continues to run in the system tray. 
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Chapter 7••••  
TAPI Client Services 

Overview 

Iwatsu Client Services which works in conjunction with Iwatsu Enterprise Services to enable the 
following features on TAPI-compliant client applications: 

 Incoming call screen pop of TAPI-compliant application contact record on a Client PC. 

 Make an outbound call via an Iwatsu telephone from a Windows application such as Microsoft 
Outlook. 

 Place a call on hold / retrieve a call from hold within a TAPI compliant application. 

 

Client Applications Screen-Pop Outdial 
Outlook  

2000 and above No Yes 

ACT!  
Version 5 and below Yes Yes 

Features 

Client Services which works in conjunction with Iwatsu Enterprise Services to enable the following 
features on TAPI-compliant client applications: 

 Incoming call screen pop of TAPI-compliant application contact record on a Client PC. 

 Make an outbound call via an Iwatsu telephone from a Windows application such as Microsoft 
Outlook. 

 Place a call on hold / retrieve a call from hold within a TAPI compliant application. 

Important! 
Third-party applications are outside the control of Iwatsu Voice Networks and 
may require customization to support the above features.  

 

Client Applications Screen-Pop Outdial 
Outlook  

2000 and above No Yes 

ACT!  
Version 5 and below Yes Yes 
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Using the Windows Phone Dialer 
Use the Windows Phone Dialer to verify that Iwatsu TAPI is working properly. 

Place an Outgoing Call 
Use the Windows Phone Dialer to place an outgoing call. 

1. From the tool bar, select the Dial icon. 

 

2. When the Dial window appears: 

 Enter the telephone number you wish to Connect to: 

 Select Place Call. 
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3. The Preview and Phone Call screen pops will appear while you are waiting for the called party 
to answer. 

 

4. When the called party answers, Connected will appear in the Phone Call window. 

 

5. When you or the called party disconnects the call, Disconnected will appear in the Phone Call 
window. 

 

6. When the call has ended, you may Close the Preview and the Phone Call windows. 
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Receive an Incoming Call 
Use the Windows Phone Dialer to receive an incoming call. 

1. When you receive an incoming call, the Preview window and the Phone Call window will 
appear showing that you have an Incoming call. Do Not select Reject Call. 

 

Warning! 
Do not click the Reject Call button. Rejecting an incoming call is not 
supported by the ECS (or any other TAPI compliant application). This will 
cause TAPI to shut down and it will need to be reconfigured. 

2. When you take a call, Connected will appear in the Phone Call window. 

 

3. When you or the calling party disconnects the call, Disconnected will appear in the Phone Call 
window. 

 

Do Not 
Select: 
Reject Call 


	Chapter 1 ( �Real IP Apps Solutions Overview
	QueVueTM
	Virtual DSS
	Call Director
	Soft (PC) Attendant Console
	AccuCall-Web
	Text Web
	Ticker Interaction
	Text Web Interaction
	Text Web Integrator

	Enterprise Services Phone Book

	Chapter 2 ( �AccuCall-Web Advanced
	Introduction
	AccuCall-Web Advanced Advantages
	Details
	AccuCall-Web Advanced Report Manager Navigation Overview
	AccuCall-Web Advanced Advantages
	Contents Tab
	AccuCall-Web Advanced Reports

	Properties tab:
	Troubleshooting
	Uninstall SQL Server 2005
	Configuring IIS Settings for Workgroup
	Encryption Key Error
	Report Server Receives an Error when Connecting to the Database
	Login Screen Pops when Running the Reports and the Login Screen will not take my Username and Password
	Running Reports from a Remote Computer
	Cannot Run Reports after a Computer Name Change

	Chapter 3 ( �QueVueTM
	Overview
	QueVueTM Agent Features
	QueVueTM Administrator Configuration and User Guide
	Main Screen Overview
	File Menu
	
	Import ECS Database


	Help Menu
	Server
	Agent ID
	Agent Logins
	
	Priority Tab


	ACD Groups

	QueVueTM Agent User Guide
	Pop-Up Menu
	Call Queue Indication
	Main Screen Overview
	Call Control
	ACD
	ACD Group Call Queue


	Chapter 4 ( �Soft (PC) Attendant Console
	Overview
	Features
	Network Phonebook
	Configuration
	Enable Single Step Transfer

	Voicemail Configuration
	Omega-Voice Configuration
	
	Configuring Menus



	User Guide
	Main Screen Overview
	Idle Call Screen
	Active Call Screen
	File Menu
	Options Menu
	Call Menu
	Help Menu
	Department Menu

	Double-Click or Right-Click Menu
	Edit the PhoneBook
	Show Current Dept Only
	Show Active Call Entries
	Configure the PhoneBook


	Chapter 5( �Virtual DSS
	Overview
	Features
	Virtual DSS Console Operation
	Virtual DSS Console Setup
	Import a Phone Book Using Iwatsu Enterprise Services
	Add Extensions to the Virtual DSS Console
	Virtual DSS Options
	Exit the Virtual DSS Console
	Virtual DSS Console Help

	Virtual DSS Console Operation
	DND (Do Not Disturb)
	Park
	Transfer to Voice Mail
	Transfer a Call
	Group Park
	Dialing

	Right-Click Menu
	Announce Transfer
	Forward
	CCV Audible
	Display DSS / CCV Key Information


	Chapter 6 ( �Call Director
	Overview
	Call Director Topography

	Features
	Call Director User Guide
	Overview
	Dial – Make a Call
	Answer – Receive a Call
	Hold – Place a Call On Hold
	Transfer - Transfer a Call
	VM Transfer- Transfer to Voice Mail
	Record – Call Record
	Close – Close the Application Window


	C
	Chapter 7( �TAPI Client Services
	Overview
	Features
	Using the Windows Phone Dialer
	
	Place an Outgoing Call
	Receive an Incoming Call





